Ex. No:1                                           Practicing Rational Rose
Aim:

To study and understand the Rational Rose Software and to Practice it features for Software Development.

Introduction

Rational Rose is the Case tool that supports the Rational Unified Process (RUP), a methodology for object oriented systems analysis and design, and based on the UML notation.

The Rational Software Corporation produces a whole range of products that together form a complete CASE environment – The Rational Suite. The whole suite is comprehensive and COMPLEX. It can be used for modeling business requirements, systems design, managing documentation, data modeling, automated code generation in several languages, implementation, testing, project planning and handling change requests.

At this point we will be looking at a very small part of the Rational Rose part of the suite

Rational Rose is a visual modeling tool, enabling the creation, analysis, design and modification of components in a software system.

Setting up Rational Rose for the first time

· Start up the PC and logon as you would normally

· Using windows explorer or My Computer, go to the C: drive

· Create yourself a subdirectory/folder called Rational

· Then create a further sub directory/folder within it for your project

· Exit Windows Explorer

Running Rational Rose

Find the icon for Rational Rose Enterprise Edition in the Program menu and click on it to open it. This will load the Rational Rose software, giving you the opening screen, from here you can select a new model or an existing model.

Saving the Diagram

When you have finished your diagram, click on File/Save from the menu bar. Make sure that you are saving it to the correct folder. 
Running Rational Rose
[image: image1.emf]When starting rational rose the following screen is displayed, click on cancel (unless you have already started the diagram in which case click on recent or existing and select the required project).

The screen should now look like this:

Parts of the screen 

1. [image: image17.png]= [_[CIx]

E vi o Browse Report Queyy Took

DedlyzB|a w0
& nited)

(03 Use CaseView El Class Diagram: Logical View / Hain

3 LogealView

3 Compeonert View
Deplyment View
@ Modsl Properies

For Help, press F1 | 7|




Browser

2. Toolbar

3. Diagram area


The browser shows the main diagrams you can produce for a project (in this case it is untitled) and there are three main diagrams, the use case view, the logical view and the component view. In this example we wish to produce a class diagram so we need to be using the logical view. If you click on the + beside the logical view folder it will expand to show what makes up the logical view. The browser will change as you add to the diagram these extra elements correspond to what you have added.

Ex. No: 2                                      Data modeling using Rational Rose
Aim:

To explore the options of generating data modeling diagrams using rational rose tool.

Actors and Use Cases

Creating Actors

1. Right click on the Use Case View package in the browser to make the shortcut menu visible.

2. Select the New:Actor menu option.  A new actor called New Class is placed in the browser.

3. With the actor called New Class selected, enter the desired name of the actor.

Creating Use Cases

1. Right click on the Use Case View in the browser to make the shortcut menu visible.

2. Select the New:Use Case menu option.  A new unnamed use case is placed in the browser.

3. With the use case selected, enter the desired name of the use case.

Creating the Main Use Case Diagram

1. Double click on the Main diagram in the Use Case View in the browser to open the diagram.

2. Click to select an actor in the browser and drag the actor onto the diagram.

3. Repeat step 2 for each additional actor needed in the diagram.

4. Click to select a use case in the browser and drag the use case onto the diagram.

5. Repeat step 4 for each additional use case needed in the diagram.

Note: Actors and use cases may also be created directly on a use case diagram by using the toolbar.

Creating Communicate-Associations

1. Click to select the Association icon or the Unidirectional Association icon from the diagram toolbar.

Note: If the Association icon is not present on the toolbar, it may be added by right clicking on the toolbar, selecting the Customize menu choice from the shortcut menu, and adding the icon to the toolbar.

2. Click on an actor initiating a communication and drag the association line to the desired use case.

Creating Include Relationships

1. Click to select the Dependency icon from the toolbar.

2. Click on the base use case and drag the Dependency icon to the used use case.

3. Double click on the dependency arrow to make the Specification visible.

4. Click the arrow in the Stereotype field to make the drop-down menu visible, and select include.

5. Click the OK button to close the Specification.

Creating Extend Relationships

1. Click to select the Dependency icon from the toolbar.

2. Click on the use case containing the extended functionality and drag the Dependency icon to the base use case.

3. Double click on the dependency arrow to make the Specification visible.

4. Click the arrow in the Stereotype field to make the drop-down menu visible, and select extend.

5. Click the OK button to close the Specification.

Creating Additional Use Case Diagrams

1. Right click on the Use Case View in the browser to make the shortcut menu visible.

2. Select the New:Use Case Diagram menu option.

3. While the use case diagram is selected, enter the name of the actor.

4. Open the diagram and add actors, use cases and interactions to the diagram as needed.

Activity Diagrams

Creating Activity Diagrams

1. Right click on the Use Case View in the browser to make the shortcut menu visible.

2. Select the New:Activity Diagram menu choice.  This will add an activity diagram called NewDiagram to the browser.

3. While the new diagram is still selected, enter the name of the diagram.

4. Double click on the activity diagram in the browser to open the diagram.

Creating Activities

1. Click to select the Activity icon from the toolbar.

2. Click on the activity diagram window to place the activity.

3. While the activity is still selected, enter the name of the activity.

Creating Transitions

1. Click to select the state transition icon from the toolbar.

2. Click on the originating activity and drag the transition arrow to the successor activity.

Creating Decision Points

1. Click to select the Decision icon from the toolbar.

2. Click on the activity diagram window to place the decision.

3. While the decision is still selected, enter the name of the decision.

4. Click to select the Transition icon on the toolbar.

5. Click on the originating activity and drag the transition to the decision icon.

Creating Guarded Transitions

1. Click to select the State Transition icon from the toolbar.

2. Click on the decision and drag the transition to the successor activity

Note: Rose may place the transition on top of an existing transition.  To separate the transition, select the transition and drag it onto the activity diagram window.

3. Double click on the transition arrow to make the Specification visible.

4. Select the Detail tab.

5. Enter the guard condition in the Guard Condition field.

6. Click the OK button to close the Specification.

Creating Synchronization Bars

1. Click to select the Horizontal Synchronization or the Vertical Synchronization icon from the toolbar.

2. Click on the activity diagram window to place the synchronization bar.

3. Click to select the State Transition icon on the toolbar and add any needed incoming and outgoing transitions to the synchronization bar.

Creating Swimlanes

1. Click to select the Swimlane icon from the toolbar.

2. Click on the activity diagram window to place the swimlane.  This will add a swimlane called NewSwimlane to the diagram.

3. Double click on the NewSwimlane (the words) to open the Specification.

4. Enter the name of the swimlane in the Name field.

5. Click the OK button to close the Specification.

6. To resize the swimlane, click on the swimlane border and drag the swimlane to the desired location.

7. Drag all needed activities and transitions into the swimlane. (Note; You may also create new activities and transitions in the swimlane.)

Creating Starting and Ending Activities

1. Click to select the Start State or the End State icon from the toolbar.

2. Click on the activity diagram window to place the start or end state.

3. If you added a start state, click on the State Transition icon, click on the start state, and drag the transition to the first activity in the workflow.

4. If you added an end state, click on the State Transition icon, click on the successor activity, and drag the transition to the end state.

Classes and Packages

Creating Classes

1. Right click to select the Logical View in the browser.

2. Select the New:Class menu choice.  A class called NewClass is placed in the browser.

3. While the new class is still selected, enter the name of the class

Creating Attributes

1. Right click to select the class in the browser and make the pop-up menu visible.

2. Select the New:Attribute menu choice.  This will create an attribute called Name in the browser.

3. With the new attribute selected, enter the desired name.

Creating Operations

1. Right click to select the class in the browser and make the pop-up menu visible.

2. Select the New:Operation menu choice.  This will create an operation called opname in the browser.

3. With the new operation selected, enter the desired name.

Creating Packages

1. Right click to select the Logical View in the browser.

2. Select the New:Package menu choice.

3. While the package is still selected, enter the name of the package.

Creating Inheritance

1. Open the class diagram that will display the inheritance hierarchy.

2. Click to select the Class icon from the toolbar and click on the open class diagram to draw the class.

3. With the class still selected, enter the name of the class.

Note:  The class could also be created in the browser and added to the open class diagram.

4. Click to select the Generalization icon on the toolbar.

5. Click on a subclass and drag the generalization line to the superclass.

6. Repeat step 5 for each additional subclass.

Relocating Classes

1. Click to select the class in the browser.

2. Drag the class to the desired package.

3. Repeat the steps for each class that is to be relocated.

Sequence and Collaboration Diagrams

Creating a Sequence Diagram

1. Right click to select the use case in the Use Case View of the browser and make the shortcut menu visible.

2. Select the New:Sequence Diagram menu choice.  An unnamed sequence diagram is added to the browser.

3. With the new sequence diagram selected, enter the name of the sequence diagram.

Creating Objects and Messages in Sequence Diagrams

1. Double click on the sequence diagram in the browser to open the diagram.

2. Click to select the actor in the browser.

3. Drag the actor onto the sequence diagram.

4. Click to select the Object icon from the toolbar.

5. Click on the sequence diagram window to place the object.

6. While the object is still selected, enter the name of the object.

Note: You may also drag existing classes onto the sequence diagram window.

7. Repeat the preceding steps for each object and actor in the scenario.

8. Click to select the Object Message icon from the toolbar.

9. Click on the actor or object (or class) sending the message and drag the message line to the actor or object receiving the message.

10. While the message line is still selected, enter the name of the message.

11. Repeat steps 7 through 9 for each message in the scenario.

Creating Collaboration Diagrams from Sequence Diagrams

1. Double click on the sequence diagram in the browser to open the diagram.

2. Press F5 key.

3. Rearrange the objects and messages on the diagram as needed.

Relationships

Creating an Association Relationship

1. Click to select the Association icon from the toolbar.  The association icon may be added to the toolbar by right clicking on the toolbar and selecting the Customize menu command.

2. Click on one of the associated classes in a class diagram.

3. Drag the association line to the other associated class.

Creating an Aggregation Relationship

1. Select the Aggregation icon from the toolbar.  The Aggregation icon may be added to the toolbar by right clicking on the toolbar and selecting the Customize menu command.

2. Click on the class playing the role of the “whole” in a class diagram and drag the aggregation line to the class playing the role of the “part”.

Creating Multiplicity

1. Double click on the relationship line to make the Specification visible.

2. Select the Detail tab for the role being modified.

3. Enter the desired multiplicity in the Cardinality field.

4. Click the OK button to close the Specification.

Creating Package Relationships

1. Select the dependency relationship icon from the toolbar.

2. Click on the client package and drag the arrow to the supplier package.

Statechart Diagrams

Creating Statechart Diagrams

1. Right click to select the class in the browser and make the shortcut menu visible.

2. Select the New:Statechart Diagram menu choice.  This will add a state diagram called NewDiagram to the browser.

3. While the diagram is still selected, enter the name of the diagram.

4. To open the diagram, click the + to expand the class in the browser, click the + to expand the State/Activity Model in the browser and double click on the statechart diagram in the browser.

Creating States

1. Click to select the State icon from the toolbar.

2. Click to place the state on the statechart diagram.

3. With the state still selected, enter the name of the state.

Creating State Transitions

1. Click to select the State Transition icon from the toolbar.

2. Click to select the originating state on the statechart diagram.

3. Drag the state transition to the successor state.

4. If the state transition is a named transition, enter the name while the state transition arrow is still selected.

Creating Start States

1. Click to select the Start icon from the toolbar.

2. Click on the statechart diagram to draw the Start icon.

3. Click to select the State Transition icon from the toolbar.

4. Click on the Start icon and drag the arrow to the desired state.

Creating Stop States

1. Select the Stop icon from the toolbar.

2. Click on the statechart diagram to draw the Stop icon.

3. Select the State Transition icon from the bar.

4. Click on the state and drag the arrow to the Stop icon.

Adding State Transition Details

1. Right click on the state transition arrow to make the shortcut menu visible.

2. Select the Open Specification menu choice.

3. Select the Detail tab.

4. Enter the action, guard and/or the event to be sent.

5. Click the OK button to close the specification.

Creating Entry Actions, Exit Actions and Activities

1. Right click on the state to make the shortcut menu visible.

2. Select the Open Specification menu choice.

3. Select the Actions tab.

4. Right click in the Action field to make the shortcut menu visible.

5. Select the Insert menu choice.  This will create an action called entry.

6. Double click on entry to make the Action Specification visible.

7. Select when the action should occur: on entry, on exit , do or on event.

8. Enter the action or event information.

9. Select the type: action or send event.

10. Enter the action name and event information (if needed).

11. Click the OK button to close the Action Specification.

12. Click the OK button to close the State Specification.

Component and Deployment Diagrams

The Main Component Diagram

1. Double click on the Main Diagram under the Component View package on the browser to open the diagram.

2. Click to select a component/package and drag the component/package onto the diagram.

3. Repeat step 2 for each additional component/package.

4. Dependency relationships are added by selecting the Dependency icon from the toolbar, clicking on the component/package representing the client and dragging the arrow to the component/package representing the supplier.

Creating Components

1. Open a component diagram.

2. Click to select the Component icon on the toolbar.

3. Click on the diagram to place the component.  This will also add the component to the browser.

4. While the component is still selected, enter the name of the component.

Creating the Deployment Diagram

1. Rose automatically creates the deployment diagram.  To open the diagram, double click on the Deployment Diagram on the browser.

2. To create a node, click to select the processor icon and click on the diagram to place the node.

3. With the node still selected, enter the name of the node.

4. To create a connection between nodes, click to select the Connection icon from the tool bar, click on one node on the deployment diagram and drag the connections to the other node.
Ex.No: 3                                       Semantic Data Modeling

Aim:

To understand semantic data modeling and explore the option of semantic checking in Rational Rose tool.

Procedure:

Semantic data models define the meaning of data within the context of its interrelationships with other data.

A semantic data model is an abstraction which defines how the stored symbols relate to the real world. Thus the model must be a true representation of the real world.
Running the semantics checker:

1. To run the Semantics Checker in Rational Roseyou will have to create a new

script. In Rational Rose, click  Tools and click New Script.
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2. Add the following code to the Script Editor Window:

Dim pSemCheck As Object

Set pSemCheck = CreateObject

(“UmlSemCheck.SemChecker”)

pSemCheck.StartChecker
3. Click the Start button to run the Semantics Checker. 
[image: image2.emf]
4. Select the source of your model. In Rational Rose, models are stored in XMI files.

5. Type the path to the XMI file or click Browse to navigate to it. 
6. Click Check.
[image: image3.emf]
If errors are found, a report is generated listing all of the modeling errors.

[image: image4.emf]
EX. No:  4                                                    Rational Rose Code Generation

Aim:

To generate source code to our object model using Rational Rose Software
Procedure:
Rational Rose has an option that allows you to generate source code that corresponds to your object model.  When you generate source code, rational rose automatically creates the .h and .cpp files.  Contained in these files will be the class shells.  Rose generates the classes and adds the attributes to them.  It also creates the methods with empty bodies.  You must go in and add the body of the methods yourself.

The first step in code generation is creating or opening an object model.

You will next want to convert the classes on your diagram to ANSI C++.

To do this, you will select all of the classes on your diagram and go to the Tools menu. Under the Tools menu there is a submenu called ANSI C++. Underneath that menu is an option called “Convert from classic C++”. Select this option. Your screen will appear as follows:
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Click next. Your screen will then appear as follows:
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Click ok.  You will now have a component called converted classes.

Once you have created the “Converted Classes” component, you must add the classes to the component.  To do this, expand both the Logical View folder and the Component View Folder in the box on the left hand side of the screen. The following picture shows both folders expanded out
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Once you have expanded the folders, you must add the classes to a component. To do this, click on the classes in your logical view folder and drag them to the “Converted Classes” component.

You are now ready to generate your code. To do this, you should right click on the “Converted Classes” component. You should then select “Generate Code…” from the ANSI C++ submenu.  When you do this, the following dialog box will appear:
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You should select the directory where you want the .h and .cpp files to be deposited and click OK.  The following dialog box will appear:
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Click Select All and then OK.

You should then get a dialog box that says code generation is complete.  You can now view the C++ code that was generated.

Ex.No:5                                                Reverse Engineering

Aim:
To examine a program source code and to recover its design using Rational Rose.

Procedure:

Reverse engineering is the process of examining a program's source code to recover information about its design. The Rational Rose C++ Analyzer extracts design information from a C++ application's source code and uses it to construct a model representing the application's logical and physical structure.

Rational Rose C++ includes a C++ Analyzer, packaged as a separate executable that is invoked independently of the Rose executable.

To reverse engineer a program with the Analyzer, you

STEP 1 :  Open C++ Analyzer

Go to

  Start ( Programs ( Rational Rose ( Rational Rose RealTime ( Rational Rose C++ Analyzer

STEP 2 : Open a new project 

Go to File ( New
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STEP 3: Enter the details of the project

a) Caption : Enter a Caption.(example: Lab4 )

b) Directories :
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 Enter the directory where your source code is saved.

· Select your drive and then navigate in the directory Structure to find your directory. 

· Highlight your directory and click “Add Current”

· The selected directory will appear under the Source Directory.

· When the Analyzer analyzes a file, it stores the resulting design data in a data file. The Analyzer builds a separate data file for each analyzed file. When you export your design to Rose, the Analyzer combines information extracted from one or more data files to construct one or more model files.

· To set the data directory same as your current code directory, double click on the source directory and then click “Set to Current”. Rational Rose will now store all the data files it creates in the same directory where the code resides.

· Click OK and save your project.

c) Extensions : Enter the Extensions of the files you want to analyze . In our case it will be .cpp and .h
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d) Bases: The Base List identifies base projects required to resolve source code references to compiler-specific or library-specific header files. For today’s assignment you can leave this blank.

e) Files: Select the files you want to analyze from the “Files not in List” and click on “Add Selected”. You can select on “Add All” if you want to add all the files. Click on OK.
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All the selected files you have selected to analyze will appear under “Files”
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STEP 4: Analyze the selected program.

· To Analyze a file, Click on the file in the file list and go to Action ( Analyze (or press F3.) This will analyze that file. You can also select all the files together and analyze them at once.
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STEP 5 : Export the files to a  Rose model file.

· Select all the files

· Go to Action ( Export to Rose (or F8)

· Set the directory where you want the .mdl file to be stored. (File)

· For Option Set choose Detailed Analysis

· Detailed Analysis is for in-depth examination of pre-existing source code.
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STEP 6: The model is ready! Open the .mdl file using Rational Rose Enterprise Edition. 

Step 7: Compare the original design model of your project with the generated model. 

Ex.No: 6                                                CASE  Environments

Aim:  

To understand the CASE Environment of Rational Rose Tool.

Introduction:

An environment is a collection of CASE tools and workbenches that supports the software process. 

CASE environments are classified based on the focus/basis of integration.

   1. Toolkits

   2. Language-centered

   3. Integrated

   4. Fourth generation

   5. Process-centered

Toolkits

Toolkits are loosely integrated collections of products easily extended by aggregating different tools and workbenches. Typically, the support provided by a toolkit is limited to programming, configuration management and project management. And the toolkit itself is environments extended from basic sets of operating system tools, for example, the Unix Programmer's Work Bench and the VMS VAX Set. In addition, toolkits' loose integration requires user to activate tools by explicit invocation or simple control mechanisms. The resulting files are unstructured and could be in different format, therefore the access of file from different tools may require explicit file format conversion. However, since the only constraint for adding a new component is the formats of the files, toolkits can be easily and incrementally extended.

Language-centered

The environment itself is written in the programming language for which it was developed, thus enabling users to reuse, customize and extend the environment. Integration of code in different languages is a major issue for language-centered environments. Lack of process and data integration is also a problem. The strengths of these environments include good level of presentation and control integration. Interlisp, Smalltalk, Rational, and KEE are examples of language-centered environments.[4]

Integrated

These environments achieve presentation integration by providing uniform, consistent, and coherent tool and workbench interfaces. Data integration is achieved through the repository concept: they have a specialized database managing all information produced and accessed in the environment. Examples of integrated environment are IBM AD/Cycle and DEC Cohesion.

Fourth-generation

Fourth-generation environments were the first integrated environments. They are sets of tools and workbenches supporting the development of a specific class of program: electronic data processing and business-oriented applications. In general, they include programming tools, simple configuration management tools, document handling facilities and, sometimes, a code generator to produce code in lower level languages. Informix 4GL, and Focus fall into this category.

Process-centered

Environments in this category focus on process integration with other integration dimensions as starting points. A process-centered environment operates by interpreting a process model created by specialized tools. They usually consist of tools handling two functions:

    * Process-model execution

    * Process-model production

Examples are East, Enterprise II, Process Wise, Process Weaver, and Arcadia.

Ex.No: 7                          Project Implementation using CASE Workbenches 
Aim:

To develop sample Project and implementing Planning, Analysis, designing, Programming, Verification and Validation using Rational Rose Workbench.

PROJECTS
1. COURSE REGISTRATION SYSTEM

2. LIBRARY MANAGEMENT SYSTEM

3. ATM PROCESS

4. PAYROLL

5. TICKET RESERVATION

6. STOCK MANAGEMENT

7. ATTENDANCE

8. STUDENT MARKLIST

